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This document is a step-by-step outline of how to make image base maps for the Digital Aerial
Sketchmapping (DASM) system. Image maps can be made using many different image sources, but the
most popular has been aerial imagery produced by the National Agricultural Imagery Program(NAIP). This
aerial imagery is continuous across CONUS and is collected at regular (usually 3-year) intervals.

While the imagery provides detailed land cover information, surveyors have found that additional reference
information is helpful in geolocating features. Contour lines and/or hydrography (streams) especially help in
areas where the land cover is homogenous. Because of their large size, shapefiles of these features cannot be
efficiently displayed in GeoLink software. To address this issue, we have developed methods to integrate
the vector data into the raster imagery by ‘burning’ in the vectors - changing the raster image pixels that are
coincident with the vectors. In this document we will outline the steps to making 15m resolution, 30x60
USGS quad maps with contour and stream vectors burned into NAIP imagery. If you wish to make NAIP
image maps without any vectors burned in, the process is much simpler and is described in Appendix C.

Since most surveyors update maps for their entire survey area, our methods will focus on how to batch these
processes. In order to do that, we need to establish a ‘region’. A region will be the geographical area where
you want to make maps. This can be a NFS Region, a State or group of smaller states, or a block of 30x60
guads. We will use the state of Nevada as an example in this demo.

This demo was conducted using ESRI ArcMap 10 and ERDAS Imagine 2010 software. Basic knowledge of
these software packages is assumed. Unless otherwise stated, use the defaults assigned to parameters by the
software. A batch command file (.bcf) and a model file (.mdl) should accompany this manual; the text of
these files is included in Appendices A and B.

We will need three datasets that cover our region to make the maps:

1. A vector dataset (shapefile) of streams (hydro)
2. A 30m (or better) digital terrain model (DTM) or digital elevation model (DEM).
3. NAIP image files.

The following sections describe how to gather and process these three datasets:

1. Hydrography Files

a. Download hydro shapefiles
One data source for hydro files is TIGER census data. The data can be downloaded from
http://www.esri.com/data/download/census2000 _tigerline/index.html
On the left side of the screen, click on Preview and Download. Select the State you want and
then select the layer (not the county) desired. This will give you a list of layers. The layer
you want is Line Features — Hydrography. Click ‘submit selection’. This will produce a list
of Counties. For small states there is an option at the top of the list where you can select all
counties. For most states you have to check the boxes for the counties you want. There is a
limit of 20MB per request, so you can pick quite a few counties. The data are in
Goeographic NAD83, but there are no prj files.
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b.

C.

Process the county shapefiles

Unzip the shapefiles and load them in to ArcMAP. Because the data have no projection
information, you will get a message saying that the data can be displayed, but is not
projected properly. Click ‘Ok’. Check to see that all counties have a hydro shapefile:

(Figure 1):

Figure 1. TIGER County Hydrology shapefiles for Nevada.

Merge hydro shapefiles

Now, merge the county shapefiles into a single shapefile of hydro vectors for the entire state.
Use the ArcMap Merge tool (GeoProcessing — Merge). Next define the projection for this
merged dataset using the define projection tool (Data Management — Projections and
Transformations -->Feature--> Define Projection. Use the GCS_North_American projection
(NAD 1983.prj). Finally, reproject this shapefile to your desired projection. In our example
(Nevada) this will be UTM Zone 11 NADS3.

Create a raster file from the hydro shapefile

Use the ‘Vector to Raster’ tool in ERDAS Imagine 2010 to create the raster.

Set the cell size to 15m (Figure 2). The input vector dialog defaults to ArcCoverage; use the
pull-down menu to select ‘shapefile’.
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Figure 2. Settings to create a 15m raster file from the hydro shapefile in the ERDAS
Imagine 2010 Vector to Raster tool.

2. Contour Files

a. Gather elevation data
National Elevation Datasets (NED) data can be downloaded from the USGS site
(http://ned.usgs.gov/Ned/fag.asp). but the format is 1x1 degree tiles - many files for large
areas. You may have a source locally that is more efficient. What you want are the 1 arc-
second (approx 30m) data. An alternative is to use NED tiles available from RSAC (Contact
Scott or Charlie). These are ERDAS Imagine (.img) files, are 1 arc-second (approx 30m),
16 bit (elevation values are in meters) and are in Geographic, GRS 1980, NAD83. Using the
Tile Index map in Appendix D, we determine that tiles 10, 11, 18 and 19 are needed to cover
Nevada.

b. Mosaic NED Tiles
Now we will mosaic the NED tiles using ERDAS Imagine 2010. Open the ‘Mosaic Pro’
tool and add the tiles. Make sure the overlap function is set to ‘overlay’. It is tempting to
set the new output projection in ‘Output Options’ but my experience is that you will get
memory errors. Output data type should be signed or unsigned 16-bit, depending on if you
have any areas below sea-level (In our NV example, the NED tiles encompass Death Valley
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S0 our mosaic is signed 16-bit. The mosaic can also be done with the ‘Mosaic to New
Raster’ tool in ArcMap 10 (ArcToolbox: ‘Data Management Tools” — ‘Raster’ — ‘Raster
Dataset’. Figure 3 shows how to set up the dialog; be sure to specify 16-bit output.
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Figure 3. Mosaic to New Raster dialog in ArcMap 10.

c. Reproject NED raster file
Next, reproject the NED mosaic to the new projection. For NV, we are using UTM Zone 11
NADBS83. Figure 4 shows the ‘Project Raster’ dialog (‘Data Management Tools” —
‘Projections and Transformations’ — ‘Raster’ — ‘Project Raster’). Important: Be sure to
select ‘Cubic’ as the resampling method, and set the output cell size to 15m.
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Figure 4. ArcMap 10 Project Raster ArcTool dialog.

d. Create contour features
The next step is to create contour raster files from the reprojected NED file using the Raster
Contour tool in ERDAS Imagine 2010 (‘Terrain’ tab, ‘Raster Contour’ tool). Specify the
contour interval in meters - typically 100 or 200. In our NV example, we will create 200m

contours.
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Figure 5. Settings for the Raster Contour tool in ERDAS Imagine 2010.

3. NAIP Imagery
The NAIP program contracts with several companies to collect and process image data, this results

in some variation in data quality across states. Cooperating states and federal agencies may also
request the data in different resolutions and formats. Compressed County Mosiacs (CCM’s) are 1
meter, 3-band (R,G,B) or 4-band (R,G,B, IR), MrSID format county files; these are a standard
deliverable along with quarter-quad geoTiff files. We have primarily used the CCM products as they
typically are color-balanced and the compression makes the files relatively easy to transfer. If your
agency has NAIP data in another format, try a test mosaic to see if the color balance is acceptable.
NAIP data are available for download at the NRCS DataGateway or you can send a drive to Scott
McClarin at RSAC (smclarin@fs.fed.us).

a. Mosaic CCMs to 100k quads
Open the ERDAS Imagine 2010 ‘Mosaic Pro’ tool and add each of the CCM MrSID files.
Set the Overlap Function to ‘Maximum’. In the ‘Output Options’ dialog, set the ‘Method’ to
USGS Maps Database 1:100000 Series, collar extent to 100m, and set the output projection
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as desired. In our NV example, we will use UTM NAD83 Zone 11. Set output cell size to

5m and output data type to unsigned 8-bit (Figure 6).
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Figure 6. Output options dialog (ERDAS Imagine 2010) for mosiacing CCM files to USGS 100k quads.

b. Run mosaic

When you run the mosaic, you will be prompted for a file name. The file name you enter
will be the prefix of the 100k quad name; i.e. if you enter ‘5m_.img’ the quad files created
by the mosaic tool will be ‘Sm_<quadname>.img’. When the process has completed,
inspect the quads and see if the color balancing is acceptable (Figure 7). The Nevada quads

took approximately 35 hours to process.
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Figure 7. 5Sm image quads from the NAIP CCM’s. The blank area is Nellis Air Force Base, they dont like to
have their picture taken.

4. Burn contour, hydro features into NAIP Quads
In steps 1-3 above, we have prepared the three input files that go into making the NAIP image maps.
Next we will use an ERDAS model (.mdl) to reclass the contour pixels to yellow and the stream
pixels to blue -- “burning” the features into the image quad. Rather than laboriously running the
model for each quad, we will use a ERDAS batch commad (.bcf) file to loop through a list of the
quads. Here is a diagram of the process (Figure 8):
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Figure 8. Simplified diagram of the steps conducted by the ERDAS model and batch command file.

The batch command file 1). Defines the inputs and outputs, 2). Calls the model which burns the
features and creates the output img file, 3). Creates a world file for the output img file, 4).Exports the

img to jpg format and 5). Exports the img to MrSID format (Figure 9).
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Figure 9. The batch command file is run in ERDAS Imagine 2010 and outputs the image maps in
three different formats.

a. Define output folders
First, we need to set up some folders for the output raster burns. The batch command file
produces img, jpg and MrSID files so define a folder for each file type. Why three different
formats? Exeperience shows that the jpg format retains the contrast and tone of the imagery
when converted to the gor format (see below), and the MrSID files are highly compressed
and therefore smaller and easier to use in a desktop GIS. The folders created for the NV
project are shown in Figure 10:

s |2 CADASMImage_MapsiWyYiBurns

x Mame
() ipg
Jo| (SDsid

——

Figure 10. Three output folders were created for the NV maps.
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b. Locate the model file
Next, we need to put the burn model (.mdl) in the right place. The model file
(NAIP_Hydro_Contour_<date>.mdl) should be placed in your C:/Program
FilessERDAS/ERDAS Desktop 2010/etc/models directory.

C. Edit paths in the batch command file
Both the model and the batch command file are text files and can be edited in WordPad or
NotePad. For most projects, editing the model will not be necessary. One situation where
the model can be edited is if you want to use different band combinations (See section 5
below).
The paths and filenames in the batch command file will need to be edited for each image
map project. These lines should be edited to point to the contour and hydro raster files
created in sections 1 and 2 above:

** INPUTS - SPECIFY THE REGION HYDRO AND CONTOUR RASTERS

*/

variable INPUT_RASTER_CONTOUR Auto "c:/dasm/image_maps/nv/ned/nv_200m_contours.img";
variable INPUT_RASTER_ORIGINAL User;

variable INPUT_RASTER_STREAMS Auto "c:/dasm/image_maps/nv/hydro/nv_hydro_15m.img";
/*

Filenames for the output raster files are auto-generated by ERDAS Imagine, but we still
need to specify the output paths for each of the output raster types. Edit the paths in these
lines, being careful not to alter any of the text to the right of the $ sign:

** QUTPUTS - EDIT THE PATHS TO THE LEFT OF THE $ SIGN

*/

variable OUTPUT Auto "c:/dasm/image_maps/nv/burns2/img/$(INPUT_RASTER_ORIGINAL.root).img"
Delete_Before;

variable OUTPUT_TFW Auto "c:/dasm/image_maps/nv/burns/jpg/$(INPUT_RASTER_ORIGINAL.root).tfw"
Delete_Before;

variable OUTPUT_JPG Auto "c:/dasm/image_maps/nv/burns/jpg/$(INPUT_RASTER_ORIGINAL.root).jpg"
Delete_Before;

variable OUTPUT _SID Auto "c:/dasm/image_maps/nv/burns/sid/$(INPUT_RASTER_ORIGINAL.root).sid"
Delete_Before;

These paths should correspond to the ones created in step 4a above. Note that the path
switches are forward slashes (“/) rather than back slashes (“\”). When the paths have been
edited save the bcf file and close the text editor.

d. Start the batch command
Now we are ready to open ERDAS Imagine 2010 and launch open the batch command file.
After Imagine has started, find the Application Menu in the upper left hand corner of the
application window. The button to open the menu looks like this:

12 ‘ |
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._./ Application Menu Button

Click on the Application Menu and select ‘Batch — Open Batch Command File’. Select the

batch command file edited above. The batch command dialog will now be displayed (Figure
11):
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expartifif -inputfilename "$0UTPUT] -outputfilename ‘$0UTPUT _JPGY -bands 1 2 3 -uppe
mrzidcomprezs -erdas - '$[0UTPUTY -0 '$[OUTPUT_SIDT -truecolor 1 23 -c10-g 2 -w 4 -r
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Figure 11. ERDAS Imagine Batch Command dialog.

Click the ‘Next’ button and use the ‘Select Files to Add’ dialog button to add the NAIP 100k
quads created in step 3 above (Figure 12):
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Figure 12. Use the ‘Select files to add’ button to bring up the dialog to add the NAIP quads to the
batch.

Add all of the NAIP 100k quads for your region. For our NV project, all 95 quads for the
state of Nevada and bordering areas have been added (Figure 13):
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Figure 13. Batch Command Dialog with NV quads added.

Click ‘Finish’ and the process will start. Our demo NV project took around 5 hours to process and
export 95 quads, some of which were not full quads.
When things go wrong (note “when” and not “if”’) the session log is very handy for diagnostics.

Open the session log by clicking the App . Menu, Then selecting ‘Session Log” — ‘Open Session
log’. One of the most common errors is not setting the paths correctly so that is the first thing to

check.

After the batch has successfully run, open ArcMap and inspect the processed files.
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5. Edit the NAIP bands used in the burn model (optional)

a.

If you have 4-band data available, you can edit the model file to use the IR band (4) to create
a false color IR image map. Open the model in a text editor and find these lines:

# FUNCTION DEFINITIONS

# THE LAYERS IN THE COMMAND BELOW CAN BE CHANGED TO 4,3,2

#PULL THREE LAYERS FROM THE 4-LAYER INPUT

#define n12_memory Integer(STACKLAYERS ( $n12_NAIP(1), $n12_NAIP(2), $n12_NAIP(3)))

Change the band assignments in the last line from 1,2,3 to 4,3,2:

# FUNCTION DEFINITIONS

# THE LAYERS IN THE COMMAND BELOW CAN BE CHANGED TO 4,3,2

#PULL THREE LAYERS FROM THE 4-LAYER INPUT

#define n12_memory Integer(STACKLAYERS ( $n12_NAIP(4), $n12_NAIP(3), $n12_NAIP(2)))

Save the file and close the text editor.

6. Create the GeoLink Optimized Raster (.gor) files for use in GeoLink GPS Mapping sotfware

GeoLink Software (Michael Baker Jr, Inc), requires that large raster files be converted to proprietary
format that is optimized for fast, efficient display. This format is called gor - GeoLink Optimized
Raster). To create these files, we will use a utility that is bundled with GeoL.ink that is called
SplitTiff. SplitTiff is not a stand-alone application and so GeoLink will need to be loaded on your
image processing workstation. Creating gor files using SplitTiff is memory intensive so make sure
you have lots of RAM available.

a.

World files

World files are small text files that contain georeferencing and pixel size information. Each
jpg raster file must have a corresponding world file with the same filename and with the .tfw
extension. Since the jpg files we created have no map model information, the world files
were created from the img files in the batch command code. Sort the files by name in the
jpg folder (C:\DASM\Image_Maps\NV\Burns\jpg) to make sure each jpg file has a
corresponding tfw file.

Create the gor files

Open the SplitTiff utility (Start Menu - GeoLink Mapping System->SplitTiff) and in the
window that opens up select ‘File > Batch Process’. In the dialog select ‘Jpeg’ in the ‘Files
of type’ pull down menu and go to your jpg folder. Select all the jpg files (Figure 14):
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Figure 14. SplitTiff open file dialog with NV jpgs added.

Click ‘Open’ and the following dialog will display (Figure 15). Check the boxes ‘Use these
settings for all images in this batch’ and ‘Skip blank images’. Select the ‘Pixel elimination’
radio button. Accept the default “Width and Height of images’ values. Set the output folder
(in our demo, we have created a gor folder in the C:\DASM\Image_Maps\NV\Burns

directory). Click ‘Ok’ and the process will start.

Split TIFE
Thiz will zplit the TIFF image inta smaller v Usze these
zectionz zampled at different rezolutions. zettingz for all
The new images and an index will be images in thiz
placed ina .GOR file for uze within batch.

Geolink.

[ Compress output [TIFF-PackBits)
[v Skip blark images

Reduction Method

* Pizel elimination

" Halftane merging

" Bilinear interpolation [not fast, be patient...]

Output to:
C:ADaSkAmage_Maps\MYhBurmzhgor

Width of images:

Height of images:

OF.
Skip

1280

7

360

Figure 15. SplitTiff parameters dialog.
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Close all other programs to ensure that maximum RAM is available for SplitTiff.
After the gor files have been created, inspect them in GeoLink’s ‘View/Print Maps’ utility
(Figures 16 and 17). Be sure to set the coordinate system correctly.

% GeufL bk Foe Wiadims . [View Maps - [Map List]] .
[P tan Cowaws Jecx Yow Sndow twe wifixi
B B wndowd Pres PanCetered # BR OrewMecls st DOO DRGIW
| W AABENT SYROIAT0 V. AWEIRE BE2LABI0AL Zono: 13 Scotesa: 56 [ v <]
71— 740 20

Pue ek, sraw 1 N Error Reczedng OFF

Figure 16. Nevada 200m contour interval with hydrography image maps in GeoLink.

’ R
DASM Image Maps Manual — 1 January 2012 .



B Geufak Foe Wiadows . [View Maps - [Map List]]
[3 an Comrm ez Yo ndew (v g
B B wndowet revs PanCectered # BR OrewMecle st DOO DRGW
W -PHOSGL 1 38AT1965) Y. AL DRI 271139 Zono: 13 Scotelio 20 [ v |

Fue ek, praw 1 PN Ervor Recoedeg OFT

Figure 17. Use GeoLink’s ‘View/Print Maps’ utility to confirm successful creation of the gor files.

Since hydrography and hypsography are relatively static, it is not necessary to re-create these input files
each time new NAIP imagery is available. Additionally, these methods can be used to burn other features

into NAIP imagery — roads, railroads, power lines, etc.

This document will be updated periodically. Please contact us and provide feedback on how these methods
worked for you; these comments will help improve future versions of this document.
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DASM Support Team:

Charlie Schrader-Patton (USFS Remote Sensing Applications Center)
cschrader@fs.fed.us (541.312.4291)

Scott McClarin (USFS Remote Sensing Applications Center)
smcclarin@fs.fed.us (801.975.3353)

Aaron Morris (Michael Baker Jr., Inc — GeoLink)
amorris@mbakercorp.com (601.497.8999)

JD Mullen (USFS Forest Health and Tech. Enterprise Team)
jmullen@fs.fed.us (970.295.5852)

Don Ewing (USFS Forest Health and Tech. Enterprise Team)
deewing@fs.fed.us (970.295.5844)

DASM support is a cooperative effort between the USFS Remote Sensing Applications Center, USFS Forest
Health and Technology Enterprise Team, and Michael Baker Jr., Inc.

20 ‘ |
DASM Image Maps Manual — 1 January 2012 .


mailto:cschrader@fs.fed.us
mailto:cschrader@fs.fed.us
mailto:cschrader@fs.fed.us
mailto:cschrader@fs.fed.us
mailto:cschrader@fs.fed.us
mailto:cschrader@fs.fed.us
mailto:cschrader@fs.fed.us
mailto:smcclarin@fs.fed.us
mailto:smcclarin@fs.fed.us
mailto:smcclarin@fs.fed.us
mailto:smcclarin@fs.fed.us
mailto:smcclarin@fs.fed.us
mailto:smcclarin@fs.fed.us
mailto:smcclarin@fs.fed.us
mailto:amorris@mbakercorp.com
mailto:amorris@mbakercorp.com
mailto:amorris@mbakercorp.com
mailto:amorris@mbakercorp.com
mailto:amorris@mbakercorp.com
mailto:jmullen@fs.fed.us
mailto:jmullen@fs.fed.us
mailto:jmullen@fs.fed.us
mailto:jmullen@fs.fed.us
mailto:jmullen@fs.fed.us
mailto:jmullen@fs.fed.us
mailto:jmullen@fs.fed.us
mailto:deewing@fs.fed.us
mailto:deewing@fs.fed.us
mailto:deewing@fs.fed.us
mailto:deewing@fs.fed.us
mailto:deewing@fs.fed.us
mailto:deewing@fs.fed.us
mailto:deewing@fs.fed.us

Appendix A - NAIP Hydro Contour.bcf

** INPUTS - SPECIFY THE REGION HYDRO AND CONTOUR RASTERS

*/

variable INPUT_RASTER_CONTOUR Auto "c:/dasm/image_maps/nv/ned/nv_200m_contours.img";

variable INPUT_RASTER_ORIGINAL User;

variable INPUT_RASTER_STREAMS Auto "c:/dasm/image_maps/nv/hydro/nv_hydro_15m.img";

/*

** QUTPUTS - EDIT THE PATHS TO THE LEFT OF THE $ SIGN

*/

variable OUTPUT Auto "c:/dasm/image_maps/nv/burns2/img/$(INPUT_RASTER_ORIGINAL.root).img"
Delete_Before;

variable OUTPUT_TFW Auto "c:/dasm/image_maps/nv/burns/jpg/$(INPUT_RASTER_ORIGINAL.root).tfw"
Delete_Before;

variable OUTPUT _JPG Auto "c:/dasm/image_maps/nv/burns/jpg/$(INPUT_RASTER_ORIGINAL.root).jpg"
Delete_Before;

variable OUTPUT_SID Auto "c:/dasm/image_maps/nv/burns/sid/$(INPUT_RASTER_ORIGINAL.root).sid"
Delete_Before;

** START THE MODEL

*/

modeler "C:/Program FilessERDAS/ERDAS Desktop 2010/etc/models/NAIP_Hydro_Contours_20111201.mdI" -s -m
"$(INPUT_RASTER_CONTOUR)" "$(INPUT_RASTER_ORIGINAL)" "$(INPUT_RASTER_STREAMS)"
"$(OUTPUT)"

exportjfif -inputfilename '$(OUTPUT)' -outputfilename '$(OUTPUT _JPG)' -bands 1 2 3 -upperleft ‘$(OUTPUT.ulx)'
'$(OUTPUT.uly)' -lowerright '$(OUTPUT.Irx)' '$(OUTPUT.Iry)' -coordinatetype MAP -quality 100
mrsidcompress -erdas -i '$(OUTPUT)' -0 '$(OUTPUT _SID)' -truecolor 123 -c10-g2-w4 -n6-b 32 -gen 3
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Appendix B - NAIP_Hydro Contours 20111201.mdl

# BURN HYDRO (RASTER) AND CONTOUR (RASTER) INTO NAIP IMAGERY

# INPUTS:

# 15M RASTER CONTOUR FILE

# 15M RASTER HYDRO (STREAMS) FILE

# 5M NAIP IMAGERY FILES

# ALL INPUTS IN THE SAME PROJECTION

#

#

# set cell size for the model

#

SET CELLSIZE MIN;

#

# set window for the model

# LINE 20

SET WINDOW INTERSECTION;

#

# set area of interest for the model

#

SET AOI NONE;

#

# DECLARE THE INPUTS

# INPUT THE RASTER CONTOURS AS ARGUMENT 1

Integer RASTER n20_HYPS FILE OLD NEAREST NEIGHBOR AOI NONE arg1;

#

# INPUT THE NAIP USGS QUAD AS ARGUMENT 2

Integer RASTER n12_NAIP FILE OLD NEAREST NEIGHBOR AOI NONE arg2;

#

# INPUT THE RASTER STREAMS AS ARGUMENT 3

Integer RASTER n34_streams FILE OLD NEAREST NEIGHBOR AOI NONE arg3;

#

# SPECIFY THE NAME OF THE FINAL OUTPUT (ARG 4)

Integer RASTER n26_final FILE NEW USEALL ATHEMATIC 8 BIT UNSIGNED INTEGER arg4;
# LINE 35

#

# FUNCTION DEFINITIONS

# THE LAYERS IN THE COMMAND BELOW CAN BE CHANGED TO 4,3,2
#PULL THREE LAYERS FROM THE 4-LAYER INPUT

#define n12_memory Integer(STACKLAYERS ( $n12_NAIP(1), $n12_NAIP(2), $n12_NAIP(3)))
#

#

#

# CHANGE ANY "0" PIXELS IN THE INPUT IMAGE TO 1 (N29) --STUBBED OUT
# define n29_memory Integer(EITHER 1 IF ($n12_NAIP ==0) OR ($n12_NAIP) OTHERWISE )
#

# LINE 46

# BURN THE CONTOURS(N20) IN (N3)

#define n3_memory Integer(EITHER (COLOR (255,255,0)) IF ($n20_HYPS > 0) OR ( n12_memory ) OTHERWISE )
#

# BURN THE STREAMS (N38) IN

n26_final = EITHER (COLOR (0,0,255)) IF ( $n34_streams > 0 ) OR ( $n3_memory ) OTHERWISE;
QUIT;

#

# CONTRAST ADJUST (STUBBED OUT)

#n26_final = RASTERMATCH ($n28_memory, USEALL, $n12_NAIP , USEALL ) ;
# QUIT;
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Appendix C — Creating Image Maps — No feature burns

This section outlines the process for creating image maps for GeoLink (GL) from NAIP aerial
photography digital files for use in the Digital Aerial SketchMapping (DASM) system.

COMPILE NAIP IMAGE DATA

The first step is getting the NAIP data you need. One source is the USDA NRCS Data Gateway
(http://datagateway.nrcs.usda.gov/). On this site the Compressed County Mosaics (CCMs) can be
ordered. When your order is fulfilled, you will receive and email with an FTP link to download.
There is a limit of something like 4GB per order and 5 or so orders at a time. So if you are
downloading an entire state, it may take some time. Your agency/department may have the NAIP
data available somewhere on a drive that you can access. The CCMs typically are in the MrSID
compressed format and are 1m in resolution. We have had good success using these files in the
past. You may have data available at higher spatial resolution. Unless there is a compelling
reason, we don’t recommend using these data as we will be resampling to 5m anyway (optimal
resolution for fixed wing surveys), and the higher resolution files are much larger and more difficult
to store and process.

The NAIP CCMs will come in zip files; extract the contents of these to a folder. It is helpful to build
an ArcMap document with 100k quads (we will be building the image maps as 100k (30 x 60
degree)quads and other reference layers; load the CCM files to make sure you have coverage for
the quads you want to build:

T e

GO

e g e oe el s> ! e ] o

Figure 1 CCMs covering the extent of two quads in PA.

The CCMs have background values that are zeros for all three bands; these areas border the
actual image data and will appear black. If you want to make sure that you have adequate
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coverage for your quads, you can set the background values to ‘No color’ for each of the images in
ArcMap (Fig 2). In this example we will build the two highlighted quads in Figs 1 and 2.

|
s S i i i — - . ~ E -

[Te T s e | voven

'9-‘ w' v
Figure 2. CCM coverage for the Carlisle and State College 100k quads in PA.

RESAMPLE/REPROJECT

The next step is to resample the 1m NAIP imagery to 5m. Also in this step we will convert the
MrSID format (.sid) to the ERDAS Imagine (.img) format. The NAIP CCMS are typically projected
in their native UTM zones which can be confusing in states like PA that span different UTM zones.
Things are much simpler if you decide on a single UTM zone for your state/area of interest. In this
example, there are two UTM zones (17 and 18) in PA. We will choose UTM NAD83 Zone 17 as
the coordinate system for these quads.

Open ERDAS Imagine 2010 (Classic interface, which should be similar to older versions of
Imagine) and select the reproject utility (‘Data Prep’ button at the top). In this example, here is how
the dialog is set up:
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Reproject Images x|

Iput File: [ zid) Output File:
[orthe_1-1_Tn_s_palD1_2 | g2 [P0 20101 Smimg  ~| (3

Output Projection:

Categones:

[UTHM GRS 1980 NADE3 Narth RIS,
Projection;

IUTM Zohe 18 [Range 78w - 72w ;l
Urits: IMeters x| I lanoreZero in Stats.

Output Cell Sizes:

v |5.Dununuuuuu :I - |5.unuuuununu j Womiral.. |

[¥ Force Square Pixels on Feprojection 3

™ Set Output Corners From [nouire Biax |

L |235313.unuuuu :I L |334915.unuuuu :I

L |444423u.nuuuun :I LB |4394553.nuuuun :I

Rezample Method: INealest Meighbor LI

" Rigomus Transformation (% Polynomial Approsimation:

b aimum poly order: |3 _l::' Tolerance [pixels): 0100 =~

If tolerance exceeded:

¢ Continue &pproximation  { Rigarous Transformation

0K I Batch | Cancel I Help |

|
Figure 3. Use the ‘Reproject’ utility in Imagine to both resample and reproject the CCMs into .img
files.

Since we have 13 or so CCMs to do, we will set up a batch process. When doing large batch
runs, make sure that you have enough disk space for the produced output. Click the ‘Batch’ button,
select the ‘Modify commands automatically’ radio button then click ‘Next’. Now click the ‘Variables’
tab:
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~[0] x|

Ilze the "Inzert” and "Replace’ buttons on the "'Commands'’ tab to place
wanablez at the current curzor pozition in commandz. Yanables are defined on
the *ariablez" tab. Click “Mest:" to select filez once vanables are defined.

F Commands "«.J'arial:ulesl
${In

(A r— O
N Type: I.ﬁ.utD LI

=l a0e maps/pa_naipdFnput. roat] Sm.img Set..

¥ Delete Before Processing
[T Delete After Processing

e | Delete | IIhdo |

B Cloze I < Back | Mest = | Finizh I Help |
| 4

Figure 4. Set the Output variable in the batch command dialog.

For the ‘Output’ variable, set the pattern so that the filename reads ‘$(Input.root) 5m.img’. This
will set the output file names to the input file name with a *_5m’ added. Click ‘Next’ and in this
dialog you will select the CCM files to batch process.

~1olx|

|1ze the popup ligt to zelect the column to modity. Uze the "Select” buttan to
I add files to the lizt. The Delete button can be used to remove selected rows
. from the lizt. There must be at least one name in the lizt below o proceed.

B | npLat
@ 1 artho_1-1_1n s pal0l_2010_1.zid

=l

BE T Show Full Path = B

I [npuat

] [ Close |[Sekctfiestosdduest> | Fiish | Help |

|Select files to add s
Figure 5. Add all the files for the batch process using the ‘Select files to add’ button.
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Click ‘Finish’ and the process will run for approximately 1.5 hours per GB of CCM data (this

Batch Commands

|Jze the popup ligt ta select the columi ta madify, Uze the "Select’” button to
add files ta the lizt. The Delete button can be uged to remove selected rows
fram the list. There must be at least one name in the list below to proceed,

@
;

‘ Ry | Input

]

Tartho 1-1_Tr_g pali_2010 1.=zid
Zortho_1-1_Tr_g_pal13_2010_1.=id

Fortho_1-1_1n_s_pal27_2010_1.5id

dlartha_11_1n_s pa035_ 2010 1.sid
Bartho 1-1_Tr_z pal41_2010 1.zid
EBoartho 1-1_1n_z pal43 2010 1.=id

T ortho_1-1_Tr_gz_pal25_2010_1.=id

B ortho_1-1_1n_z_pal&7_2010_1.5id

Sortho_1-1_1n_z_pal&1_2010_1.sid
10 ortho_1-1_1n_z_pal&7_2010_1.zid
17 ortho_1-1_1n_z_pal87_2010_1.zid
12 otho_1-1_Tn_z_pa033_2010_1.aid
13 ortho_1-1_1r_z_pal08_2010_1.sid
T4 ortho 1-1_1n_ =z pall13_2010_1.sid

15 ortho_1-1_1n_z_pal33_2010_1.zd

=] @ B ShowFul Path

Cloze I

=}
=~

Help

&

Figure 6. Final dialog of the batch process utility for the resample/reproject step.

example ran for 16 hours).

MOSAIC AND CLIP TO 100K QUAD BOUNDARIES

Now we have the county mosaics resampled to 5m resolution and all in the same coordinate
system. We are ready to mosaic them together and clip to the quad boundaries. Open the
‘MosaicPro’ tool in ERDAS Imagine 2010 and go to ‘Edit’ then ‘Add Images’. Add all the 5m img

files.
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% MosaicPro (No File) =10 x|
File Edit Wiew Process Help

D EG v muwEEW B -@/(wdergaaq

| Order ‘Flef. |Vis.‘ Image Mame ‘ Area ‘Hesample‘ RIS ‘Dnline|E>:L
1 « image_mapzpa_naipdortho_1-1_Tn_z_palil_2010_|  Entire MM 00000 w
2 image_maps/pa_naipdotho_1-1_Tn_s pal33d 2010_  Entire R 13 00000
3 image_maps/pa_naipfortho_1-1_Tn_s pal41_2010_  Entire R 13 00000
4 image_maps/pa_naipdfortho_1-1_Tn_s pal33 2010_  Entire R 13 00000
] image_mapz/pa_naiplortho_1-1_Tn_z_palEy_2010_  Entire MM 00000 w
g image_mapz/pa_naiplortho_1-1_Tn_z_pal87_2010_  Entire MM 00000  w
7 image_mapz/pa_naiplortho_1-1_Tn_z_pal43_2010_  Entire MM 00000 w
a image_maps/pa_naipdortho_1-1_Tn_s_pal&1_2010_  Entire M 00000 w
9 image_maps/pa_naipfortho_1-1_Tn_s palb5 2010_  Entire R 13 00000
10 image_maps/pa_naipdfotho_1-1_Tn_s pal27_2010_  Entire R 13 00000
11 image_mapspa_naipdortho_1-1_Tn_z_pal35_2010_  Entire K13 00000 w
12 image_mapz/pa_naipfortho_1-1_Tn_z_pal08_2010_  Entire MM 00000  w
13 image_mapz/pa_naiplortho_1-1_Tn_z_pall19_2010_  Entire MM 00000 w
14 image_mapz/pa_naiplortho_1-1_Tn_z_palby_2010_  Entire MM 00000  w | |
15 image_maps/pa_naipfortho_1-1_Tn_s pall3 2010_  Entire R 13 00000

4 3

| 4

Figure 7. Add all the appropriate 5m county NAIP files in the mosaic dialog.

Now go to ‘Edit’ then ‘Output options’ and set the dialog to output the 100k quads. Also specify a
100 pixel boundary so there are no gaps between the quads (Figure 8).
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Start the mosaic by selecting ‘Process’ -> ‘Run Mosaic’. You will be prompted for a filename; this
will be the prefix for the output quads. So we will enter “PA_.img” as the output and the files will be
named PA_<quadname>.img. The mosaic and clip takes less time than the resample; about 20

"4 Output Image Options X

Define Output Map Arealz]:

ethod: ILISES Mapz Database LI

1S5GS Map Series: |1:1EIEIEIEIEI 'I

Specify Callar Extent: [ itz Ipi:-:els TI E =tent: I-“:IE1 3:

[~ Clip Boundary I j =

Output Data Tepe:

| Urisigned 8 kit ~|

Change Output b ap Projectian...

Output Cell Sizes

s |5.nnnnnnnn :I - |5.nnnnnnnn :I |mete,3 v|

Mumnber of [nput lapers: 3

|1:3

Select Layers:

Ilze a comma for zeparated liztfi.e. 1,35 ] or enter ranges

wzing a 't e 25 & layer may appear at most once.

k. I Cancel | Help |

Figure 8. Set the output options for the mosaic process.

minutes for this demo dataset.

Before proceeding, it is a good idea to look at a few of the 100k 5m image quads in ArcMap just to
make sure that they look good. If so, the next step is to make world files for the image quads.
World files are small text files that contain pixel size and corner coordinate information; some
software applications (like GeoLink) require them to properly georegister images. To make the

world files, use the image command tool in ERDAS (Tools -> Image Command).
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. Image Commands: (pa x|

Image File:
I pa_bradford.img j =
[ Change Raster Type Continuous ;I
[T Compute Statistics [ ptios... |
[~ Compute Pyrarnid Layers [ptions... |
[ Delete Pyramid Layers
[T SetMoDataalue 0.000000 :II
[T Clear HoD ata Yalue
[T Change Map Model [ pticnz,..

[ Delete Map Model

[+ Map tadel to ' orld File a_bradford.iguw

[T Change Map Projection [ ptios... |

[ Delete Map Projection

[~ | Set Elewation Sounce [ ptiots... |
[ Add/Change Elevation Info [ ptiohs... |
[~ Remove Elevation Info [ ptios... |
[T Recalculate Elevation Yalues [ptions... |
[~ Prirt Ta File [ ptiors... |
[ Rename file I d =
[~ Delete file

] I Batch | Cancel | Help |
|

Figure 9. Use the image command tool to make the world files (.tfw).

Select one of your quad images, check the ‘Map Model to World File’ button and the click the
‘Batch’ button. We will batch this process as above. Click the ‘Modify commands automatically’
and then the ‘Next' button. In the dialog that appears, select the ‘Variables’ tab:
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. Batch Commands

Ilze the "Inzert’ and "Replace" buttons on the "'Commands" tab to place
wvanablez at the current curzor pozition in commands. Wariables are defined on
the "arablez" tab. Click “Mext:" to select filez once wanables are defined.

Cormands  “anables I

M [=IEY

F;
$(Inp
| InEut M ame: I Cutput
N Type: I.ﬁ.uh:- ;I
Fatterm: m_image mapsdpa naip/ 3l nput root]. e Set
¥ Delete Before Processing
[T Delete After Processing
e | Delete | Lndo |

Cloze I ¢ Back | M et = | Eirmizh | Help |

4

Figure 10. Make sure the output variable for the world files batch is $(Input.root).tfw.

Highlight the ‘Output’ variable and make sure the output file name is $(Input.root).tfw. GeoLink
world files need to have the tfw extension regardless of what raster type they reference. Click
‘Next’ and in the next dialog select all of the PA_<quadname> .img files and then click ‘Finish’.
You should now have a world file (PA_<quadname>.tfw) for each of the img files in the output

directory.

Now we will make jpg files from the img files, which will then be used to create gor (GeoLink
Optimized Raster) files that can be used in GeoLink. Click the ‘Import’ button on the mail tool bar
and select 'JFIF(JPEG)’ as the output type; then select your input/output and click the ‘Ok’ button:
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Import/Export - O] x|

" lmport £ Export

Type:  [JFIF IPEG) | *
hedia; I File ;I #*
[nput File: [%.imag] Output File: [%.jpal

/pa_naip/pa wiliarmsport wiest, inno E'? Ipa_williamspu:urt_west.ipg d E?

pa_CUMBERLAMD.img ;|
pa_HAGERSTOWN.img
pa_HARRISBURG.img
pa_JOHMSTOW M. imng

=

pa_STATE_COLLEGE.img
n= SRR irme h
< | _'*I_I
|a pa_naip j |ﬁ 4] j

| ] I Cloze | [ata Wiew.. Help |

Figure 11. Initial dialog for export to jpeg files from img files.

Next, you will see this dialog:

Export JFIF Data x|

Input File: pa_bradford.img

Layers: 3 Fows: 11793 Calz: 17159

Contrast Options

[™ Use Standard Deviation Stretch

Standard Dewviations: 200
Quality: I 75 3:
0k | Export Options ... | Help I

socr_|

Figure 12. Dialog for jpeg export options.
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Make sure the ‘Use Standard Deviation Stretch’ is NOT checked — it will be checked by default.
Accept the default quality setting of 75. Click the ‘Batch’ button and set up the output file name
variable to $(Input.root).jpg:

=1k

Ilz& the "Inzert' and "Replace’ buttons on the "'Commands" tab to place
wanablez at the current curzor pozition in commands. YWariables are defined on
the "ariablez" tab. Click “Mext:" to zelect filez once warables are defined.

o Cornmatds Variablesl
$(Inp

o ra— |
N Type: |ﬁut|:- LI

Pattern; | ERiSE=] ' ' Set...

¥ Delete Before Processing
[T Delete After Processing

[ [=1EN | Delete | Lndo |

EE Clogze I ¢ Back | et = | Eirizh | Help |
| 4

Figure 13. Be sure to set the output file name to $(Input.root).jpg

Click ‘Next’ and in the next dialog add all the img quad files to export to jpg. Click ‘Finish’ and when
the jpgs have been created, make sure they are in the same folder as the tfw files made in the step
above:
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-3l x|
File Edit View Favorites Tools Help ‘ 'f,'
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5 < Data (D}) ™ pa_york.jpg 22,267 KB JPEG Image
' |i4] pa_williamsport_west.tfw 1 KB TFW File
2 1155f3b16f090318b7b6 ™ pa_williamsport_west.jpg 41,402 KB JPEG Image
D) AGX_Cache |i4] pa_williamsport_east.thw 1 KB TFW File
= Aircraft_models ™ pa_williamsport_east.jpg 6,505 KB JPEG Image
I Backup |i4] pa_wellsboro.tw 1 KB TFW File
I CharlieStuff ™ pa_wellshoro.jpg 3,540 KB JPEG Image
&) Crypt |i4] pa_tyrone.tf 1KB TFW File
5 £ DASM_Image_Maps ™ pa_tyrone.jpg 25,821 KB JPEG Image
& GYce |i4] pa_towanda. tfu 1 KB TFW File
. ™ pa_towanda.jpg 3,246 KB JPEG Image
(D Michigan |i4] pa_sunbury.tfr 1 KB TFW File
2 Models ™ pa_sunbury.jpg 16,891 KB JPEG Image
El [ PA_NAIP |i4] pa_state_college.tf 1 KB TFW File
2 jpg ™ pa_state_college.jpg 54,788 KB JPEG Image
= 3 R6 1| |4] pa_johnstown.tfw 1 KB TFW File
[ Oregon ™ pa_johnstown.jpg 26,873 KB JPEG Image
) Ref_SHps |i4] pa_harrisburg.tfu 1 KB TFW File
) Seripts ™ pa_harrisburg.jpg 23,142 KB JPEG Image
3 Tables |i4] pa_hagerstown.tfw 1 KB TFW File
™ pa_hagerstown.jpyg 31,851 KB JPEG Image
D test |4] pa_cumberland.tfw 1 KB TFW File
O Digital_Photes ™ pa_cumberland.jpg 14,509 KB JPEG Image
(=) Downloads |i4] pa_clearfield.tfus 1 KB TFW File
[ File_Utilities ™ pa_clearfield.jpg 8,733 KB JPEG Image
I3 Garmin |i4] pa_carlisle.tfuw 1 KB TFW File
() Image_Library ™ pa_carlisle.jpg 51,061 KB JPEG Image
) Interop_Cache |i4] pa_bradford.tfw 1 KB TFW File
o tevmerrint BT Tarnlate X | ™ pa_bradford.jpg 3,106 KB JPEG Image
< [ Ll | ol

Figure 14. There should be a companion .tfw file for every .jpg file.

Now we are ready to move to GeoLink and create the gor files. SplitTiff is a utility that is installed
with GeoLink. If you haven'’t already, install GeoLink on your desktop workstation. Creating gor
files requires considerable memory that might not be available on a survey tablet PC. SplitTiff is
fully functional without a GeoLink license key or code. Launch the program from the start menu
Start->All Programs->GeoLink Mapping System-> SplitTiff. From the bare-bones user interface,
select ‘File->Batch Process’ and add all the jpg files.
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Split TIFF

T hiz will =plit the TIFF image into zmaller v Usze these oK.
zections sampled at different rezolutions. gettings for all
The new images and an index will be images in thiz Skip
placed in a .GOR file for uge within batch.
GeoLink.

[™ Compress output [TIFF-PackBits) Width of images: 1620

¥ Skip blank images

19 e 8

Height of images: 10A0

— Reduction Method
{* Pixel elimination

™ Halftare merging

™ Eilinear interpalation [not fast, be patient...]

— Dutput ko

D-ADASM_Image. MapsyPa, NAIF

Figure 15. Settings for the SplitTiff utility.

After the jpg files load, a dialog box appear (Figure 15). Set the output folder as desired, making
sure there is enough disk space. Accept the default settings that come up for the width and height
of images (they are based on your screen resolution), and select ‘Pixel Elimination’ for the
Reduction Method, check ‘Skip blank images’ and do NOT select ‘Compress output’. Check the
box that says ‘Use these settings for all images in this batch’. Click ‘Ok’ to start the process. When
the processing is complete, the SplitTiff window will read ‘Split complete’ in the title bar. Go to the
output folder to confirm creation of the gor files.

Lastly, confirm that your gor files are working properly by displaying them in GeoLink. You can do
this by either opening them in a simulated log session (with or without GPS), or using ‘View/Print
Maps’. View/Print maps is buggy so if you don’t have success, try a log session. Be sure to set
the coordinate system for the gor files — GeoLink cant display data properly unless it “knows” what
the projection is. Also, be sure to use the ‘Cropping’ function as it will eliminate any blank (black)
areas between the images. Add another dataset to the map list to confirm that the new gor files
are georegistering properly. In this example, we have added a quad boundary shapefile (Figure
16).
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GeoLink For Windows - [View Maps - [Map List]]
H Maps FEeatures Setup View Window Help

=10l x|
‘ =181x]|
H @\ ‘ Q ‘ Windowed | Previous | Pan Centered ’ ’ @\ ’ Draw Map List’ Exit
) Lat 41.1294768093 Lon:-77.1553663437 30‘3'9[109.98 U”itSIMiles L]

EEE 2020 2 109.94)

For Help, press F1

[ [um 4
Figure 16. Newly created gor files displayed in GeoLink.

That’s it. You have created survey-ready gor image maps from NAIP data.
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PROCESSING NOTES

In this example we have created just two quads; typically we process an entire state using these
described methods. Processing times can be long and with lots of disk space required so plan
accordingly. Some file sizes from this example can be useful in planning disk space requirements:

100 k Quad ERDAS Imagine (.imq) JFIF JPEG(.ipg) GeolLink Raster (.gor)
State College 587 MB 55 MB 279 MB
Carlisle 591 MB 51 MB 281 MB

You can also create MrSID files from the img files; these can be handy to use in GIS software.
SplitTiff can ingest a number of different raster formats — tiff, MrSID, bmp, etc. We have had the
best success using jpg as the input image format as the contrast seems to be better than when
using tiff as the input.

Processing performance seems to be better if you are reading from one drive and writing output to
another, especially if external USB drives are involved.

ENVIRONMENT

This example was conducted using ArcGIS 9.3.1, ERDAS Imagine 2010, and GeoLink v 6.2.11.15
software on a Dell Intel Pentium Core 2 Duo (3.00 GHz) PC with 4 GB of RAM running Windows
XP.

37 *
DASM Image Maps Manual — 1 January 2012



Appendix D. Map for locating NED Tiles

Attachment 1: NED Index
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